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Drainage Design Management System for Windows, Version 1.5
Installation Instructions

1) Insert the DDMSW CD in the CD drive (here denoted as X:). The CD contains
an autorun file and installation should begin automatically. If not, from
the Start menu, type X:\DDMSW\Setup at the RUN command (substitute your CD
drive letter for X) .

2) Follow the instructions on the screen. Once installation has finished,
start the program by double-clicking on the DDMSW icon. You will receive
the following message:

Note ~

CJ;> Path and name to Help Reader file not found.

I You must edit File\Setup before proceedingl

3) Click OK.
4) Next, you will see the following screen:

Drainage Design Management System

Version 1.5

Flood Control District of
Maricopa County

This program has been written to aid in the management of
watershed modeling. The use of this program and results
developed, are the responsibility of the user.

KVL Consultants, Inc.

5) Click "I Agree".



6) Next, you will see the following screen:

Path to Model Runs 1'?:~!~M.~~.,?~~~.D':::~~~!)(~~~':::~1\
~=~~=;J~~..~.... :~!f::"'= -"=

7) Click the Exit button.



,
I

8) Next, you will see the following screen:
- -

Select Project

Drainage Design Management System

Path to Model Runs not found.
In File. select Edit and establish correct path.

, Project Local

'1')
Path to Model RL (~

Select Project
projeCII-EX-A-..~-~L-E-1---3 ~

9) Click OK.
10) From the pulldown menus at the top of the main DDMSW screen, choose

FILE I SETUP. You should see the following screen:

mSystem Setup RlilEI

Agency IFlood Control District of Maricopa County

User IJoe Hydrology

Help Reader Ir-C-:lP-R-O-G-RA-M-FI-L-ES-lA-DO-B-E-lA-C-R-O-B-A-T-4-.0-lRE-A-D-E-R-lA-C-R-O-RD-3-2-.E-X-E---~=·

Text Editor IC:lPROGRAM FILES\WINDOWS NTlACCESSORIESWORDPAD.EXE

Required Paths and Names

11) To use the DDMSW help files, you must have Adobe Acrobat installed on your
system. Included in the DDMSW installation is the setup file for Adobe
Acrobat 4.0, or you access the free download from www.adobe.com.



12) If you do not have the Adobe Acrobat Reader, you can use the installation
file that was included in the setup. Go to C:\DDMSW\ADOBE\ and run the
setup file "rs40eng.exe" Once Acrobat is installed, type C:\PROGRAM
FILES\ADOBE\ACROBAT 4.0\READER\ACRORD32.EXE in the Help Reader block, as
shown in the above screenshot. Note: The exact path may differ from what
is shown. If so, type in the correct path, or use the Browse option (the
button with three dots) to find the correct path.

13) If you already have Adobe Acrobat Reader installed on your system, type in
the correct file path in the "Help Reader" block, or use the Browse option
(the button with three dots) to find the correct path.

14) Similarly, you must also define which text editor DDMSW should use (usually
NotePad or WordPad) by typing the correct file path in the "Text Editor"
block, or using the Browse button to locate the correct file. See above
screenshot for example of using WordPad under Windows NT.

15) For detailed instructions on using the program, please see the User's
Manual, which can be accessed through the HELP pull-down menu, or opened
directly from C:\DDMSW\HELP\MANUAL.PDF.
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A table is a grouping of data. The data is dynamic because it can be modified, deleted,
added to, and so on. Here is an example of a table:

System Overview

1. Introduction

The program is written in Microsoft Visual FoxPro and currently includes modules for File
Management, Hydrology and Utilities. Future versions will include modules for Hydraulics
and GIS (Geographic Information System) integration.

1-1

Sort
10
20

Description
Major Basin 01
Major Basin 02

BasinlD
01
02

The Drainage Design Management System for Windows (DDMSW) has been written to
facilitate data management and computational procedures required for drainage analysis
in Maricopa County. This manual serves as a guide in the use of the program and is
intended to be used in conjunction with the County's Drainage Design Manuals.

Basic Database Terminology

The application stores data (values) in a relational Database. This data is organized into
tables, fields, and records to make it more meaningful. For example, 01 by itself is
meaningless. However, in a table called 'Basins', in a field called 'Basinld', in a record
corresponding to 'KVLTEST1', we now understand that 01 is a major basin in project
KVLTEST1.

Unlike the former DDMS which was DOS based and stored data in separate ASCII files,
DDMSW is a relational Database that manages multiple projects from on single location.
DDMSW is a multi-tasking window based application which enables the user to open
several 'windows' simultaneously. New features include pull-down menus, user-friendly
forms which the user can arrange on the desktop, and windows editing tools to facilitate
data entry. DDMSW utilizes a relational Database that includes Tables for data entry and
editing. Each Table appears as a separate '.dbf file on disk. The Tables are related to
each other based on the key field 'Project Id' which is established when starting a new
project. Running models is automated from a menu and the data for running the models
is extracted from the various Tables in the Database.

Table: Basins

ProjectlD
KVLTEST1
KVLTEST1

A table is composed of one or more fields. In the example, the fields are ProjectlD,
BasinfD, Description, and Sort. Fields are similar to columns in a spreadsheet. All fields
in a table have the same format (eg. text of maximum 70 characters, numeric 12 places
with 2 decimals) and they share the same characteristics (eg. they are different
descriptions).

KVl Consultants. Inc
Drai~ Design Management System - Uoer'l Manual
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The software used in DDMSW includes:

The procedure will notify the user when the DDMSW installation is complete.

All required software for DDMSW is contained on the CD provided with this application.

The user can choose the program's location, but assuming C:\DDMSW, the following
directory structure will be created:

1-2

Compiled application
Most recent HEC-1 with modifications
Rainfall model
County's DOS program
County's DOS program
County's DOS program
Text editor

Program files
Adobe Acrobat installation files
Directory for archiving data
Data Files
Help files
Default directory for model runs
Model programs
Reports

DDMSW
HEC-1
Prefre
MCUHP1
MCUHP2
Rational
WordPad

C:\DDMSW
C:\DDMSW\Adobe
C:\DDMSW\Backup
C:\DDMSW\Data
C:\DDMSW\Help
C:\DDMSW\ModeIRuns
C:\DDMSW\Models
C:\DDMSW \Reports

Adobe Acrobat Reader

This manual and all help files require Adobe Acrobat Reader to view and print the files. If
Adobe Acrobat Reader is not currently installed on your computer, then it will be
necessary to install the program. The latest version can be downloaded from Adobe's
website at WWW.Adobe.Com. Follow their instructions to download 'Acrobat Reader'.
Alternatively, a copy has been included in the Adobe sub directory of this installation.
Double click on the program file and follow the instructions on the screen.

Insert the DDMSW CD in the CD drive (here denoted as X). Run X:\DDMSW\Setup from
the RUN command (substitute your CD drive letter for X). Follow the instructions on the
screen.

A table also consists of one or more records. Records are similar to rows in a
spreadsheet. In the example, "KVLTEST1, 01, Major Basin 01, 10' compose one record
in the table 'Basins'. The example shows a total of two records and four fields.

In DDMSW, the Database is composed of numerous tables which organize and store
information. These tables are linked by one common key field, projectid which identifies
the project the records are associated with.

KVl ConsuIlllnts. Inc
Drai~ Deaign lAanllgemenl Syslem - U•• Manual
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Starting the Software
DDMSW is started by running 'DDMSW.exe'. The program can be accessed from the
Windows Startup menu or other selected folder or by double-clicking on the icon.

When the software is first started, it is necessary to edit File\Setup to establish system
settings.

I
KVl Consultants, Inc
Drainage Design Maneg_t system - Uwa Manual
92-38.doc
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Locates records based on a specified search criterion. Highlight the field
to search and type the search expression.

2. General Features

2-1

Moves to the previous record.

Moves to the next record.

Goes to the last record in the table.

Goes to the first record in the table.

51
rrtDminBge Design MBnBgement System - KVLTESTl

The Main Menu is the center of the application. This is the screen which is displayed
when the user starts the application. This is also the screen the user is always returned
to after closing a submenu or form.

Specific actions can be accessed through the pull-down menus shown on the Main Menu
bar. This manual will explain the functions available on each menu and will describe the
individual elements shown on data entry screens.

There is a toolbar of standard buttons, which is identical on each data entry screen.

KVl Consultants, Inc
Drain_ Design Management System - UIM'. Manual
92·38,doc
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1-·

Selects a subset of records according to user specifications. A filter
consists of one or more conditions which compares a field to a value
using an operator. Multiple conditions can be combined together with a
connector. To create a filter, select the 'Add' button. The following 'Filter
Condition' dialog box appears.

Select a field and an operator, enter a value and click 'OK'. (For
alphanumeric fields, select a value from the pull down list).

On the 'Filter' dialog box, the user has the following options:

i) Click 'OK' to execute the filter and view the subset of records.
ii) Select 'Add' again to add other condition to the filter.
iii) Select 'Store' to save the filter for future use. This is useful for

commonly used filters.

Till"·, Jtj,

n -'''''.-lId ,",qlJ~I'; 1''; ~ '.

To use a previously saved filter, select 'Retrieve'. Highlight the filter on
the 'Select Filter' dialog box and click 'OK'. Click 'OK' on the 'Filter' dialog
box to execute the command.

To edit a filter, retrieve it from the list, and choose 'Edit' or double-click on
the condition. After changing any of the items that make up the condition,
select 'Store' and 'OK' to save the changes.

Adds a new record.

2-2



Edit Menu

KVL Consultants, Inc 2-3
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Some forms are composed of several tabs to view data. Click on the tab for the
appropriate view.

Undo the last change made to a field.

Cut out (move) the highlighted text to the clipboard.

Copy the highlighted text to the clipboard.

Paste the text from the clipboard into the current field.

Marks the current record for deletion. Marked records are physically
deleted from disk when the Table is packed. The record will no longer
appear but still exists until the Table is packed.

Closes the current form and returns the user to the Main Menu or
previous form. Any changes made to the record are saved. Pressing
[Esc] will also close the form and return the user to the previous screen.
However, changes to the current record may not take effect.

Undo

Cut

Copy

Paste

The Edit menu is available to the user during data entry or editing. The menu comprises
the following functions. Some or all may be available depending on the action currently
being executed.

Forms
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3. File

New

Project

ID~

The selection of New from the File Menu is used to create a new project. It is necessary
to fill in the Project 10, Title and the path to the model runs on the Title form. The Project
10 will be used throughout the application for all files that refer to this project. Model runs
for all projects will have the same naming convention. It is therefore necessary to
establish separate folders for each project's model runs. Create the folder using
Windows Explorer and then use the.. button to locate the folder.

When finished with the Title data, enter the Hydrology default data. The Hydrology view
varies depending on which model is selected.

I
I

KVl Consultants. Inc
Drainage Design Management System - User's Manual
92-38.doc

3-1



I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

Open
To open an existing project, make a selection from the drop down list.

Edit
The selection of Edit from the File Menu is used to edit an existing project. All data on
this form can be modified except the Project 10. If it is necessary to change the Project
10, "Rename" the project in Management. If default data is changed, make sure that the
appropriate data on other forms is also modified. For example, if the reach routing
method is changed from "Normal Depth" to "Kinematic Wave", it will be necessary to
modify the routing data.

I
I
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Management
The Management menu offers the following functions:

Copy a Project

Creates a new project and copies
all records in the Tables to the
new project. Model files are not
copied. Select the current
project from the drop-down list
and enter the name of the new
project in the 'To' field. Click the
'Copy' button.

Select the project from the drop­
down list and click the 'Delete'
button. All relevant records in the
Tables are deleted. It is
recommended to pack the
Database to erase the deleted
records from disk (see 'Utilities').

Use this function to change the
name of a project. Select the
project from the drop-down list
and enter the new project name
in the 'To' field. Click the
'Rename' button.

KVL Consullllnta, Inc 3-3
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Backup Project

This form can also be used to get rid of "orphans" in DDMSW by clicking on "Cleanup
Tables". Orphans records are records in a Table that do not belong to a Project 10.
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Use this option to backup project
data to one 'zipped' file. The
backup file is saved to the
backup SUbdirectory and has the
project name with a '.zip'
extension,

When the 'Import' button is
clicked, a dialogue box appears
for the user to select a project
backup file (.zip extension). If
the project already exists in the
Database, a message appears to
warn the user that all data in the
current project will be deleted
and replaced with the imported
data. The user has the choice to
continue or cancel.

This option backs up the default
data to a file 'defaults.zip· in the
backup subdirectory. To restore
the default data, copy the
defaults.zip file to the data
subdirectory and unzip the file.

3-4
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Setup
The selection of Setup from the File Menu is used to edit System settings. These include:

• Agency name
• User's name
• Path and file name to Adobe Acrobat Reader which is necessary to view help files.
• Path and file name for a text editor.

I
KVl Consultants, Inc
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Rainfall
Prefre

4. Hydrology
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The selection of Prefre from the Hydrology\Rainfali menu is used to edit data required for
running the Prefre model and to run the model. The Prefre program computes the
rainfall depths for the durations and return periods shown on the form. The user must
enter appropriate values for all fields shown on the form. The selection of data can be
obtained from the County's Drainage Design Manuals.

Rainfall Pattern
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The selection of Rainfall Pattern from the Hydrology\Rainfali menu is used to view the
calculated rainfall pattern for the project. The data is calculated using procedures
established in the County's Drainage Design Manual and cannot be edited.

I
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6 Hour Distribution Defaults

O.BO 0.90 0.90 2.10 HO

;D 1.60 1.60 2.00 3.50 4.30

45 2.50 2.50 3.00 5.10 5.90

',0 3.30 3.'0 4.BO 7.10 7.BO
""j 4.10 '.20 6.30 B.70 9.BO

!CI 5.00 5.10 7.60 10.50 11.90

5.BO 5.90 9.00 12.50 14.10

6.60 6.70 10.50 ".30 16.20
)0 1.40 1.60 11.90 16.00 lB.60

I' B.10 B.l0 13.50 1190 21.20-, 9.90 10.00 15.20 20.10 23.90

'31. 11.BO 12.00 17.50 23.20 27.10
II':; 13.BO lB.30 22.20 2B.l0 32.10
:"0 21.60 25.20 30.40 36.40 '0.60
~ 1.:;, 37.70 45.10 41.20 50.00 51.50
~ 40 83.'0 69.40 6700 65.80 62.70

20' 91.10 83.70 79.60 17.30 13.50
~ il) 93.10 90.00 B6.BO B4.10 BUD
,~t; 95.00 93.80 91.20 8B.80 86.'0

The selection of 6 Hour Distribution Defaults from the Hydrology\Rainfali menu is used to
edit the default values for the rainfall patterns. The values should only be modified with
caution as the default values are published by the County.

Soils

Data
The selection of Data from the Hydrology\Soil menu is used to add or edit soil data
required for the Sub Basins.

The important values to enter are the Sub Basin 10 which must match a Sub Basin 10 in
the Sub Basins Table, a Map Unit code, which will come from the Soil Defaults ,and the

area for this soil. All of the remaining values can be calculated using the fii!!!ii
button.

I
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It is important to enter appropriate values for all fields as soil calculations for the entire
project will be based on these values. When first entering this form for the project, if soil
default data does not exist, the County's default data is loaded into the system.

Defaults
The selection of Defaults from the Hydrology\Soil menu is used to add or edit soil defaults
required for the Sub Basins.

.... , .. , ,. I'

t' I '111 tI
" •••. "\".,,, •... ,,'>,., .,. ".,-",,- ..

. 11011'111·,' Ilid' j '1 ,I , .,; • I

I!H-------+----------------'
I:H-------t----------------',',
~------+----------------',

!9+------t----------------I:,
I!t+-------+----------------I!,
Iitt-------t----------------,.
~------t----------------,,'.

ISH-------+----------------,,
1iOI-t-------t----------------,

There are three columns in the Soil Parameters section of the form. The first column,
Value, is the value that will be used in the modeling analysis. The second column, Calc'd,
is the calculated value based on the soil default values. The third column, Custom,
ensures that a user entered value will not be overwritten with the calculated value when
updating data.

Soil Surveys
The selection of Soil Surveys from the Hydrology\Soil menu is used to add or edit soil
surveys. This data is used to filter data on the Soil Data form.

I
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Land Use

Data
The selection of Data from the Hydrology\Land Use menu is used to add or edit land use
data required for the Sub Basins.

The important values to enter are the Sub Basin lD which must match a Sub Basin ID in
the Sub Basins Table, a land use code, which will come from the Land Use Defaults and
the area for this land use. All of the remaining values can be calculated using the
"Update Data" button.

There are three columns in the Land Use Parameters section of the form. The first
column, 'Value', is the value that will be used in the modeling analysis. The second
column, 'Default', is the calculated value based on the land use default values. The third
column, 'Custom', ensures that a user-entered value will not be overwritten with the
calculated default value when updating data.

Defaults
The selection of Defaults from the Hydrology\Land Use menu is used to add or edit land
use defaults required for the Sub Basins.

I
KVL Consultants, Inc,
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Sub Basins

Basins

The selection of Sub Basins from the Hydrology\Basins menu is used to add a new or edit
an existing Sub Basin.

4-5

Major Basins

The selection of Major Basins from the Hydrology\Basins menu is used to add a new or
edit an existing Major Basin.

Sub Basins are drainage areas within a Major Basin. Sub Basin lOs are designated by a
six character field and must be unique within a project. The preferred practice will be
to designate the first two characters with the Major Basin 10 and the remaining four
characters in some systematic order.

It is important to enter appropriate values for all fields as land use calculations for the
entire project will be based on these values.

Major Basins within a project are drainage basins that generally have a major outfall.
Major Basins will have separate HEC-1 input files and their 10 is designated by a two
character field. Single digit numbers must therefore be preceded by a zero. Within a
project, the first Major Basin 10 is designated as "01", the second as "02" etc. until Basin
"99" is reached. If the number of basins exceeds ninety-nine, a new project must be
started. It is necessary to have at least one Major Basin (01) in a project.

Fields appearing on the Sub Basin form will vary depending on the defaults established in
the project setup. For example if the Clark Unit Hydrograph is selected as the default,
then the parameters for an S-Graph will not be available. There are three columns in the
Rainfall Losses section of the form. The first column, Value, is the value that will be used
in the modeling analysis. The second column, Calc'd, is the calculated value based on
the default values in Land Use and Soils. The third column, Custom, ensures that a user
entered value will not be overwritten with the calculated value when updating data.

KVL Consuitanlll. Inc.
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IYP'd,- recalculates all values based the procedures established in the County's

Drainage Design Manuals. Values with the Custom box checked will not be updated.

Routing
The selection of Routing from the Hydrology\Basins menu is used to add a new or edit
eXisting Sub Basin or Reach routing data.

If Sub Basin is checked in the "Type" box at the top of the form, then Sub Basin routing
data is available for editing. Likewise, if Reach is selected, then reach routing is available
for editing. The Sub Basin 10 must be unique and must match an 10 in the Sub Basin
data. The Reach 10 must be unique within a project.

I
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Distributions

Time-Area
The selection of Time-Area from the Hydrology\Distributions menu is used to edit Time­
Area distributions used for the Clark Unit Hydrograph. Only data in the "Manual" column
can be edited. Time-Area is only available if "Clark" is selected as the default unit
hydrograph.
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S-Graph
The selection of S-Graph from the Hydrology\Distributions menu is used to edit S-Graph
distributions used for the S-Graph Unit Hydrograph. Only data in the "Manual" column
can be edited. S-Graph is only available if "S-Graph" is selected as the default unit
hydrograph.
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This function runs the HEC-1 model for selected Major Basins within a project.

Run HEC-1

HEC-1

4-8

Highlight the Major Basin to model and select the appropriate return period. The results
of the model run(s) will be place in a user defined directory established in the project
defaults. The resultant file names will be distinguished by the Major Basin and return
period being modeled.

The HEC-1 data is used for all return periods. When running the model, the appropriate
rainfall data is inserted for the particular return period. When 'Update HEC-1 Data' is
selected, the sub basin and routing data is updated from the relevant Tables in the
Database.

Note: DDMSW uses a special version of HEC-1 to facilitate data management.
Using another version of HEC-1 will result in errors during the importing of final
results.
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Edit HEC-1 Data

This selection allows the user to add a new HEC-1 file or edit an existing Major Basin
HEC-1 file within a project.
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The data in this file can be exported to an ASCII file to facilitate editing by clicking on the
"Export" button and following the instructions on the screen. When finished with the
editing, the file can be imported by clicking on the "Import" button. Importing replaces the
existing data for the selected Major Basin. To view a different Major Basin's data, use the
Major Basin pull-down menu.

View Summary Results

This displays summary results of model runs. The data cannot be edited.
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I

Clicking on "Hydrograph, Routed, Combined or All", will filter the data to the selection.
The data can also be ordered by "Sub Basin or Numeric" where Numeric is the natural
order from the model results.

I
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View Output File

Select a file from the file selection dialogue box. The text editor opens the ASCII model
output file. When finished viewing, close the window by clicking ~, otherwise the text
editor program will remain loaded in memory.

Develop Draft Model Data

The selection of Develop Draft Model Data from the Hydrology\HEC-1 menu is used to
develop draft HEC-1 data from the Sub Basin and default data used in the project. The
program will replace any existing data for the selected Major Basin in the HEC-1 data
file and should only be used at the beginning of a project. The program requires the Sub
Basin data to be available. If "Create Draft Routing Cards" is selected, available routing
data will be appended to the draft file. It will be up to the user to place the routing cards
in the appropriate location.
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To be developed

KVL eoosultants, Inc
Drainage Design Management System - User's Manual
92-38,doc

5. Hydraulics

5-1



I
I
I
I
I
I
I

II
I

I
I
I
I
I
I
I
I
I
I
I

To be developed

KVl Consultants
Drain ,Inc

92
age Design Me

-38.doc nagemenl S
ystem - User's Manual

6. GIS

6-1



I

The selection of Export Data from the Utilities menu is used to export a Table from the
Database to a file in a different format. All the record data in the Table are exported.
Note that the Table contents are not removed, but are copied to a different file format.
The file formats supported include:

I
I
I
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I

Export Data

Sub Sa 5
O.f.Un'''',.,=...-=-p.-::tt.-m-.--'
OefaultNsa ReduCtion Factors
lIIajor Basins In Project
Field Descriptions In Tables
able used In Filtering Records

HEC·\ Mod.1 O.t.
amp Table (or ImpOrting HEe-1 Peak Flows

Summary for HEe-1 Peak Flows
Land Use Data for Sub Basins

ProJectPatt:ems
Default Patterns for 6 Hour Storm

Project Description and Defaults
Default PSIF and OTHETA
Proj.ct R.lnf.1I O.t.
Parameters tor IOF Relationships
Rational Method Analysis
Reach Routing P;ramBters,

7. Utilities

I
CSV Data is exported into a file one record per line, with each field separated by a

comma. Character fields are enclosed in quotes. For example:

projectid ,Iucode ,dthetadesc ,v egcov er,rtimp ,ia ,kn ,kbdesc ,group ,descript ,c1 0 ,iadesc ,sort
"BET.AD10" ,"M" ,"Dry" ,25.0,0,0.25,0.050,"Max" ,"" ,"MOUNTAIN" ,0.00,"" ,10
"BET.AD10" ,"H" ,"Dry" ,3o.o,0,0.15,0.040,"Hi" ,"" ,"HILLSLOPE" ,0.00,"" ,20
"BET.AD10" ,"0" ,"Dry" ,30.0 ,0 ,0.35 ,0.030 ,"Low" ,'". ,"DESERT RANGELAND" ,0.00,"" ,30

Select this type to create an spreadsheet which can be opened in Microsoft Excel.

Exports data into a format that can be read by a Database program such as
Dbase or FoxPro.

Data is exported one record per line in ASCII text that can be read by any text
editor. The data is in fixed format (columns). For example:

HOUHTAIH
HIllSlDPE
DESERT RAHGElAHD

25.1 1 1.251.l5lMi1x
31.1 1 1.151.IIoIH1
31.1 1 1.351.13"0.

Dry
Dry
Dry

"H
D

~ETAt11
BETAt11
BETAt11

OBF

TXT

XLS

I

I
I

I

I
I
I
I

KVl eooaultants. Inc
Drain~ Design Management System - User's Menual
92-38.doc

7-1



I
I
I
I
I
I
I
I
I
I
I
I
I

Use the mouse to highlight the Table and select an export type from the drop down
selection box, then click 'Export'. The contents (all records) of the selected Table is
saved on disk in the chosen format. The user is prompted to enter a filename and
location for the export file.

Import Data

It is important that the data to be imported has the same structure as the importing
Table, otherwise fields will be truncated and records rejected. For this reason, a

The selection of Import Data from the Utilities menu is used to import data originating
from another source, such as a spreadsheet, text file or another database, into a selected
table. The file formats supported include CSV, TXT, DBF, and XLS, as described in
'Export Data'. There are two options:

I
I
I
I
I
I

• _Append to Existing Data

• Replace Existing Data

KVl Consultants, Inc
Drainage Design Management Syalem - User's Manual
92-38,doc

This option adds the data to the existing data. The
results will include the current and the newly
imported data.

This option deletes the current data in the table, and
then replaces it with the new data.
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Pack Tables

Table Descriptions

7-3

..:JReports......,,'.,--.

, Caution: Packing Tables take a few minutes to complete.
• Do not interrupt the process once it has begun.

This function rebuilds the Table indexes, and then packs all Tables in the Database.
Packing is the process of permanently removing records that have been marked for
deletion. Once a Table is packed, records cannot be recovered. Packing recoups disk
space occupied by deleted records. It should not be necessary to pack the Database
frequently, but on occasion after many records have been deleted over time.

Highlight the Table to append or replace, select the file type and click 'Import'. The
following dialogue box appears for the user to select the file to import. Highlight the
filename and click 'OK'.

good practice is to first export a Table and then use the exported file as a template for the
acceptable format.

The selection of Table Descriptions from the Utilities menu is used to view the name and
description of Tables used in the application. The data cannot be edited.

The selection of Field Descriptions from the Utilities menu is used to view the structure of
each Table used in the application. The data cannot be edited.

KVL Consultants. Inc
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The selection of Import DOS Family from the Utilities menu is used to import data
developed in the DOS version of DDMS.

If the above files are not available for the "family': then not all of the required data will be
imported and the remaining required data will have to be entered manually into the
Database.

Enter a Project ID, title and location for the data to be imported. This is the same
information as starting a new project. The click the "Import n button. The program will
import data as follows:

7-4

From a file with an .SBR extension
From a file with an .LDF extension
From a file with an .SUB extension
From a file with an .SUB extension
From a file with an .SUB extension
From a file with an .PFI extension
From either *M11 or *M21

Sub Basin Area data
Default Land Use data
Sub Basin Land Use data
Sub Basin Soil data
Hydrograph Type
Precipitation data
Storms, duration,Timearea,NMIN

KVl ConllUitanls. Inc
Drainage Design Management System - User's Manual
92-38.doc
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8. Help and Window

Help
This option on the Help menu displays a list of manuals that the user can view. Highlight
a manual and click.HI1g;<i.. Acrobat reader opens the manual on the screen. When
finished viewing, close the Acrobat screen otherwise it will remain open on the desktop.
(The path to Acrobat Reader must be entered in System Setup.)
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Help

About

This displays the informational screen for the application.

l': :0>:,," ..,......... .,
."

Window
Two options are available on the Window Menu.

Arrange All
Use this to cascade all open forms on the screen. Alternatively, the user can press
'Ctrl T' at any time to arrange forms.

Close All
Use this to close all open forms. Pressing 'Ctrl A' has the same effect.

KVL Consultants. Inc
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The steps to establish a new project through to running the HEC-1 model and viewing the
results are as follows:

Example

There are a number of Projects that have been used to test the application. The data in
these projects can be reviewed by importing the Project to see how data is entered for the
various type of default settings. The following are the default values for the various Beta
Projects:

Introduction

Ex-1

Loss Method

Green-Ampt
Green-Ampt
Green-Ampt
Init & Uniform
Init & Uniform
Green-Ampt
Green-Ampt
Init & Uniform
Init & Uniform
Green-Ampt
Green-Ampt
Init & Uniform
Green-Ampt
Green-Ampt

Duration

6 Hour
6 Hour
6 Hour
6 Hour
6 Hour
24 Hour
24 Hour
24 Hour
24 Hour
6 Hour
6 Hour
6 Hour
24 Hour
24 Hour

Storms

Single
Single
Single
Single
Single
Single
Single
Single
Single
Multiple
Multiple
Multiple
Multiple
Multiple

Hydrograph

Clark
Clark
S-Graph
Clark
S-Graph
Clark
S-Graph
Clark
S-Graph
Clark
S-Graph
Clark
Clark
S-Graph

1. Establish Path for Model Runs

2. Create New Project and Establish Defaults

3. Establish Rainfall Data for Project

4. Establish Land Use Defaults

5. Establish Soil Defaults

6. Establish Land Use Data

7. Establish Soil Data

8. Establish Major Basin

9. Establish Sub Basin Data

10. Establish Routing Data

11. Develop Draft HEC-1 Input File

12. Edit Draft HEC-1 Input File

13. Run HEC-1 Model

14. View Model Summary Results

Project 10

KVLTEST1
BETA010
BETA020
BETA030
BETA040
BETA050
BETA060
BETA070
BETA080
BETA090
BETA100
BETA110
BETA120
BETA130

KVl Consultants, Inc
Drainage Design Management System - Uws Manual
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1. Establish Path for Model Runs
Create a folder for the HEC-1 model runs. For this example, a new folder
C:\ddmsw\kvltest1 has been created.

I
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2. Create New Project and Establish Defaults
Select New from the File Menu and fill in data for Title and Hydrology defaults.
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3. Establish Rainfall Data for Project

Select Prefre from the HydrologylRainfall Menu. Fill in data shown below.

Click _Ry.nfref!'1J1 to run the Prefre model and establish rainfall data as shown below.

I Y,.) ... n -j39 1 "1 1 3~
,12 )(i

,HC' Ai 00 I ,. I f~· 20i , J7 ':'f,
? H;j'~;Fo' Oi I 51 1.81 15) a5 ) '51

6 HO.IF. 2) I 70 ~ OJ : ..19 : 85 20 , 01

I, H('UP 35 I 9; 2 J I 234 315 6c'5 , .,9
:;:4 YOIJP 5J ,15 2% It' ') 134 10 5

1" ..
'''',.
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Click, to create a new record and fill in the data for the first record as shown below.
Use appropriate Tables in the County's Drainage Manual for reference.

To add new records either create a new record as just described or click liWRec@j
(use Browse to view data) and edit the data for the new record.

4. Establish Land Use Defaults
Select Defaults from the Hydrology\Land Use Menu. The first time you come to this
screen, it will look like the following screen. This screen will look different if "Green-Ampt"
is not the default Loss Method.

Ex-4KVl Consultants, Inc
Drainage Dasign Management System - User's Manuel
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5. Establish Soil Defaults

Select Defaults from the HydrologylSoil Menu. If Soil Default data does not exist for this
project, then the County default Table will be loaded. The user can then modify the data
to establish different defaults to be used for this project. If it is necessary to add new
data, then do it in the same manner as adding new records for the Land Use Defaults.
The following view is shown in Browse mode.

, -H I ~ .. h"Ji:~ T'CJfldijr"r.l.,rj .
• '" RlIlU/tlb8i;~Rac.alll~ ".;~,..:

~_ ~ .~" .....'*': 1':~.,>;~i:~L" ,...:.... :. ~ _ :..-:_;;;,";' n~ ,

I .. sari" ,r ',-, I'njoct D7-7" ''''''':;-~- .~.'IRi '"
..

'{i 'l.!!
..-m•.\'L~~STI Maricopa .0..1 0.41 .;;;

20 "'lfEoT I Maricopa .0..2 0.41

30 "'LT"STI lIlaricopa A 3 0.58
40 V,,'LTE~T 1 Maricopa A 4 0.58
50 ""UEST I lIl.rlcopa A 5 0.43
60 "\'UEST' Maricopa A 6 0.62
70 VvLTESTI lIlarlcopa .0...1 0.62
80 V'/lTESTI Jrltarlcopa .0._8 0.98
90 V·'L.TESTI Maricopa .0..9 0.27

100 V"UESTI lIlaricopa A 10 0.94
110 V"LTESTI lIlaricopa .0..11 0.94
120 V'/L-ESTI Waricopa .0..12 0.01
130 ,"'Il,"STI Maricopa .0..13 0.01
140 ,"'IL EST! lIlaricopa .0..14 1.04

150 ~:.(LTESTI Maricopa A 15 0.54

160 I(vL"ESTI lIlaricopa "-16 O.H 15.0
170 ~"LTEST' lIlaricopa "-17 O.H 15.0
180 ~"LTESTI lIlaricopa .0..18 0.33 15.0
inn ,1-',1 Tc.J.!l. ~ ......,. ..." .. A 1 n,; .. , n.n .::.".' '+'r.. "

6. Establish Land Use Data

Select Data from the HydrologylLand Use Menu. Add or Copy records to populate the
necessary data as shown below. It is only necessary to add the Sub Basin 10, select the
Land Use and add the Area in square miles. Then click to populate the Default
Values. If a non-default value is used, it will be necessary to check the adjacent Custom
box. Values with adjacent Custom box checked will not be updated.

Be sure to enter land use data for each Sub Basin 10 in this Project and make sure there
is sufficient land use data to cover the entire Sub Basin.

I
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Be sure to enter soil data for each Area 10 in this Project and make sure there is sufficient
soil data to cover the entire Area ID's area.

8. Establish Major Basin
Select Major Basins from the HydrologylBasins Menu. Add or Copy records to populate
the necessary data as shown below. Each hydrology model run will be for a unique Major
Basin 10. Select 01 for the first basin, 02 through 99 for other Major Basins.

7. Establish Soil Data
Select Data from the HydrologylSoil Menu. Add or Copy records to populate the
necessary data as shown below. It is only necessary to add th~ Sub Basin 10, select the
Map Unit and add the Area in square miles. Then click d to populate the Default
Values. If a non-default value is used, it will be necessary to check the adjacent Custom
box. Values with adjacent Custom box checked will not be updated.

Ex-6KVl Consultants, Inc
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9. Establish Sub Basin Data
Select Sub Basins from the HydrologylBasins Menu. Add or Copy records to populate
the necessary data as shown below. Forms may look different depending on the
established project defaults. To populate the remaining data, click "Update Data". This
updates all records for the Sub Basin data for this Project.

Following the Update Data, if there are any errors or values falling outside standards,
then a report will come to the screen that can be printed. Review this report to see what
needs to be fixed.

10. Establish Routing Data

Select Routing from the HydrologylBasins Menu. Add or Copy records to populate the
necessary data as shown below. Forms may look different depending on the established
project defaults.

I
I
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I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

11. Develop Draft HEC-1 Input File

Select Develop Draft Model Data from the HydrologylHEC-1 Menu. Select the
appropriate Major Basin and check whether or not to create Draft Routing Cards. Click on
"Create Draft".

12. Edit Draft HEC-1 Input File
Select Edit HEC-1 Data from the Hydrology\HEC-1 Menu. Select the appropriate Major
Basin ID. . &E:Ilil~Jf~l'"' l\ ffi&l~j ttV,l<~il ~~ ,dt! . -f' " , KVlTEST,

- -, ir -Alljjni)a '()pdiiiiOilai~t, '.. - .. .,: ., 01

.. • : . t .~lr-1;'~ p: '"'. ,,~'\ ..., ~ •

" flOC.ImI.' -." "~- Ill'."t..~: . .. .. , .
RS 6 STOR ·1 ,",

RC 0.035 O.oJ8 0.035 4224 0.0012 99.70

r RX 510.0 1510.0 1585.0 1596.0 1600.0 1612.0 1662.0 2262.0
RY 99.7 94.1 93.6 92.2 92.2 93.6 94.9 99.7,,,,, I,.i 'lilO!UJ1l . - i'

" " , "
RS 6 STOR ·1
RC 0.035 O.oJ8 0.035 4224 0.0012 99.70
RX 510.0 1510.0 1585.0 1596.0 1600.0 1612.0 1662.0 2262.0
RY 99.7 94.1 93.6 92.2 92.2 93.6 94.9 99.7 ..

'10 . > ,1."":Jf
.. "'. .~,..,~;, ..

.,
RS 6 STOR -1

RC 0.035 0.039 0.035 4224 0.0012 99.70
RX 510.0 1510.0 1595.0 1596.0 1600.0 1612.0 1662.0 2262.0
RY 99.7 94.1 93.8 92.2 92.2 93.6 94.9 99.7. .~ :',' t9<,.....~~;. I~"!. <'RS 6 STOR -1

RCI 0.035 0.039 0.035 4224 0.0012 99.70

RXI 510.0 1510.0 1585.0 1596.0 1600.0 1612.0 1662.0 2262.0
RY 99.7 94.1 93.6 92.2 92.2 93.6 94.9 99.7 '"'... ...' . , . . . '.'!I

The best way to edit this data is to export the file to an ASCII file and edit the data and
then import the ASCII file when edits are complete. Click "Export" to export the file. A
dialogue box comes up with the default model runs path and the Basin ID. Click save.

I
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I
I The following is an example of the draft HEC-1 ASCII file (note the routing cards are at

the bottom).

I
I
I
I
I
I

.. I , 1 ,.
~ ~ ProJ.ct "', KVLTISTl - 10 T.ar Stor-.

~, IT , lOOO

I; 10 3
: KR SB' USDl
.: B.L .700
: IJJ 'S, PB Z.OOl ~; PC .000 .009 .016 .025 .0340 .042 .OS! .059 .06' .07$

.< PC .087 .100 .Il' .151 .234 .415 .163 .873 .'15 .'44

~
.1 PC .956 .", .51" . 989 1.000

.' LC _240 .260 3.950 .540 95. 000
UC 1.004 .456

.; .... a S '6 30 6S 77 S. '0 " "
~

• ~ UJ,. '00
.< lQ( sal USDl
:- .... . sao,. LC .100 .290 3.350 1.020 80. 000
•• UC .771 .273

~'l'J U.... a s 16 30 6S 11 S. '0 " "11 U'" '00

t
. ZZ
~: KR 'B' ROUT I
.Co '" 3000 O. 0040 0.030 T..... 20.0 1.0
:5 KR sal ROUTI

" '" 3000 0.0040 0.030 T..... 20.0 1.0

~l,-:

.1 ~ -- '~..-,,,,",,,,,, -- •.r.

Depending on the default routing option, the routing cards will be different. If the routing
card option was selected when developing the draft file, the records will be at the bottom
of the file. Move the routing cards to the correct location and clean up any trailing lines in
the file as follows:

and select the

")C

: III Pro~.e:t Ill, KVJ.TlSTl - '0 Yur Stora -.,
'", IT , 2.000., 10 3, KI< Sa! B.uIJI.... .700, Dr 15

- .. Z.OOl
PC .000 .009 .016 . 025 .03• .Q·U .051 . 059 .06' .07S

':"C pc .081 .100 . 119 .151 .234 .US .163 .873 .US .,...
.. PC .956 . '67 .919 .,,, 1.000
• Z LC .240 .260 3.'-'>0 .540 95.000

.- UC 1.004 .45'
:-1 U.Io a S 16 30 .. 11 S. • 0 •• ".. U.Io lOa

." KI< Sa! Il.OUTI., ... 3000 0.0040 0.030 T...... 20.0 La
:::. JQ( SBI BUIJI
. , .... .500
ZC' LC .100 .290 3.3&0 1.020 80.000
H UC .111 .213.. VA a 5 16 30 6S 77 B' '0 .. "Z3 U.Io lOa
24 KI< lB' Il.OUTI

" ... 3000 0.0040 0.030 t ...... 20.0 1. a
'::i ZZ

~.

Finally after editing the ASCII file it can be imported. Click
appropriate file to import. A dialogue box comes up for the selection.

I

I
I

I

I
I
I
I
I
I
I
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~--+----+----+--+---+---+--+--+--+-------1--' ..

pt----t----+---+--+--+--+--t--t----1I----t-- ....

~--+----+---+--+---+-+--+--+--t---;--"

!---+----+----+--+--+--+---+--l----jf---f-- ..

2---+----+----+--+---+--+--+--+-------11----+--'...

13. Run HEC-1 Model

Select Run HEC-1 from the HYC!.!9-'o9"l~tlEC-1 Menu. Select the appropriate Major Basin

ID and Return Period and click ~".

14. View Model Summary Results
Select View Summary Results from the HydrologylHEC-1 Menu.

Alternatively, the output file can be viewed in its original format by selecting View Output
File from the HydrologylHEC Model

I
I
I

II
I
I
I
I
I
I
I
I
I
I
I

II

I
I
I
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I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

Issues that need to be resolved

I) Receive the error "CSGRAPH not found" when creating a draft HEC-l with sub-basins using the
Desert/Rangeland S-graph.

2) The program allows user to duplicate Project ID when creating a "new" project under File.
3) Difficulty importing comma delineated or tab delineated ASCII files (* .txt).
4) When importing soils data, map units do not show up in "Detail" tab of the Soil Data editor. Similar

problems when importing land uses.
5) Cannot import from latest Excel version - the first record (row) is deleted during the process. User has

to save in Excel version 5.0 format for import to wwork correctly.
6) Program locks up when it encounters a non-default map unit while updating soils data.
7) When importing soils and land use data from .XLS file, the subbasin names are truncated to 5

characters.
8) If Basin and Reach Routing use different methods, there are errors in the HEC-I model created by

DDMSW.
9) Kb calculated incorrectly in the Rational Method module. (Calculations are OK in HEC-I module).
10) DDMSW does not allow user to change the number of ordinates on the IT card - always forces 2000.
II) DDMSW does not update the HEC-I file with changes to basin area (BA).

Suggested New Features

I) Installation option - silent (quiet) mode should be included.
2) Run off of network for easier upgrades and consistent multi-user database.
3) Soil survey codes should correspond to GIS specifications.
4) Create a better way to import non-Maricopa soil defaults.
5) If the program does not recognize a map unit, have DDMSW ask user to "fix" if a typo, add custom

map unit, change to a different map unit.
6) User should be able to customize the final Kb value.
7) User should be able to mix Clark and S-Graph hydrographs.



DDMSW Training Class

Exercise 1

Create an existing conditions model for Major Basin 01 using the data given on page 2.

1) Establish a new project with Project ID, EXOI
2) Manually input rainfall, soils, land use, sub basin and routing data into DDMSW.
3) Examine the warning messages generated when after updating the sub basin data.

What changes, if any, should be made to the model?
4) Create a draft HEC-l file, including routing cards. Export the draft HEC-l model to

a text file and edit using the default text editor. Add Combine cards (HC) as
necessary according to the HEC-l scematic diagram.

5) Run the HEC-l model for all return periods and view the summary results.

Exercise 2

Create a future conditions model for Major Basin 0I using the data given on page 3.

1) Note that most of the data does not change between existing and future conditions
models. Rather than re-entering the data by hand, copy Exercise1 to a new project
file with Project 10, FUTOI.

2) Change the land uses by exporting the land use data to Excel, then importing the
modified data back into the new project.

3) Update the HEC-I model and rerun it for all return periods. View the summary
results.

Exercise 3

Import a DOS DDMS family for conversion to the DDMSW format.



EXERCISE 1
MAJOR BASIN 01 - EXISTING (PRE-DEVELOPMENT) CONDITIONS
Time-Area curve: Urban Routing method: Normal Depth
Design Storm: 100 year, 6 hour Loss Method: Green & Ampt
Unit Hydrograph: Clark

Primary Zone: 7
Short Duration Zone: 8

RAINFALL DATA
2yr / 6hr 1.30"
2yr / 24hr 1.50"

100/6 3.30"
100/24 4.20"

SUB BASIN PARAMETERS
Land Uses (Area / LU in sq. mi.)

Length of
Drainage Flow ROW

Sub Basin Area [sq mil Path [mil USGE [tt] DSGE [ttl LOR MDR MFR IND COMM CROP
1A 1.14 0.75 2284 2195 1.14
18 1.34 1.02 2460 2200 1.01 0.34
1C 1.27 1.67 2400 2180 0.70 0.57
10 0.81 1.11 2220 2035 0.20 0.61
1E 0.56 0.33 2400 2205 0.56

Map Unit (Area / MU in sq. mi.)
Sub Basin 27 65 67 73 82 87 88
I 1A 0.23 0.34 0.57
j 18 0.34 0.20 0.13 0.67
I 1C 0.76 0.51

10 0.41 0.41
1E 0.56

REACH ROUTE HYDRAULIC DATA
Length Channel LOB n ROBn

Reach Slope [ft/tt] [tt] n value value value Typical Channel Cross-section
R1-2 0.001 1205 0.035 0.038 0.038 sta 510 1510 1585 1596 1600 1612 1662 2262
R2-3 0.002 840 0.035 0.038 0.038 elev . 99.7 94.1 93.6 ,92.2 92.2 93.6 94.9 99.7
R3-4 0.005 750 0.035 0.038 0.038 elmax 99.7

(I"
{",,(j

'7/, 7
~I I>7'i./i-

I
7' (.,



EXERCISE 2
MAJOR BASIN 01 - PROPOSED (POST-DEVELOPMENT) CONDITIONS
Time-Area curve: Urban Routing method: Normal Depth
Design Storm: 100 year, 6 hour Loss Method: Green & Ampt
Unit Hydrograph: Clark

Primary Zone: 7
Short Duration Zone: 8

RAINFALL DATA
2yr 16hr 1.30"
2yr 124hr 1.50"

100/6 3.30"
1001 24 4.20"

SUB BASIN PARAMETERS
Land Uses (Area 1LU in sq. mi.)

Length of
Drainage Flow ROW

Sub Basin Area [sq mil Path [mil USGE [ttl DSGE [ttl LDR MDR MFR IND COMM CROP
1A 1.14 0.75 2284 2195 1.14
18 1.34 1.02 2460 2200 1.01 0.34
1C 1.27 1.67 2400 2180 0.70 0.57
10 0.81 1.11 2220 2035 0.20 0.41 0.20
1E 0.56 0.33 2400 2205 0.56

Map Unit (Area 1MU in sq. mi.)
Sub Basin 27 65 67 73 82 87 88

1A 0.23 0.34 0.57
18 0.34 0.20 0.13 0.67
1C 0.76 0.51
10 0.41 0.41
1E 0.56

REACH ROUTE HYDRAULIC DATA
Length Channel LOB n ROBn

Reach Slope [ftIttl [ttl n value value value Typical Channel Cross-section
R1-2 0.001 1205 0.035 0.038 0.038 sta 510 1510 1585 1596 1600 1612 1662 2262
R2-3 0.002 840 0.035 0.038 0.038 elev 99.7 94.1 93.6 92.2 92.2 93.6 94.9 99.7
R3-4 0.005 750 0.035 0.038 0.038 elmax 99.7
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